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1 About this document
This operation manual is applicable for all variants of the instrument.
Read this operation manual before operating the instrument and follow the
instructions to ensure safe and trouble-free operation.
Keep this operation manual for later use and pass it on to any subsequent user or
owner.
BÜCHI Labortechnik AG accepts no liability for damage, faults and malfunctions
resulting from not following this operation manual.
If you have any questions after reading this operation manual:
u Contact BÜCHI Labortechnik AG Customer Service.

https://www.buchi.com/contact

1.1 Warning notices in this document
Warning notices warn you of dangers that can occur when handling the device. There
are four danger levels, each identifiable by the signal word used.

Signal word Meaning
DANGER Indicates a danger with a high level of risk which could result in

death or serious injury if not prevented.
WARNING Indicates a danger with a medium level of risk which could result in

death or serious injury if not prevented.
CAUTION Indicates a danger with a low level of risk which could result in mi-

nor or medium-severity injury if not prevented.
NOTICE Indicates a danger that could result in damage to property.

1.2 Symbols
The following symbols are displayed in this operation manual or on the device:

1.2.1 Warning symbols
Symbol Meaning

General warning

Dangerous electrical voltage

Flammable substances

Laser class 1

1.2.2 Mark-ups and symbols
NOTE
This symbol draws attention to useful and important information.

R This character draws attention to a requirement that must be met before the
instructions below are carried out.

u This character indicates an instruction that must be carried out by the user.

ð This character indicates the result of a correctly carried out instruction.

https://www.buchi.com/contact
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Mark-up Explanation

Window Software Windows are marked-up like this.

Tab Tabs are marked-up like this.

Dialog Dialogs are marked-up like this.

[Button] Buttons are marked-up like this.

[Field names] Field names are marked-up like this.

[Menu / Menu item] Menus or menu items are marked-up like this.
Status Status is marked-up like this.
Signal Signals are marked-up like this.

1.3 Trademarks
Product names and registered or unregistered trademarks that are used in this
document are used only for identification and remain the property of the owner in
each case.

1.4 Connected devices
In addition to these operating instructions, follow the instructions and specifications in
the documentation for the connected devices.
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2 Safety

2.1 Proper use
The instrument is designed and built for laboratories.
The instrument can be used for the following tasks:
� Purification
� Separation of one or more compounds from a mixture

2.2 Use other than intended
Use of any kind other than that described in Chapter 2.1 "Proper use", page 8 and
any application that does not comply with the technical specifications (See
Chapter 3.5 "Technical data", page 14) constitutes use other than intended.
In particular, the following applications are not permissible:
� Use of the instrument in areas which require explosion-safe instruments.
� Use of the instrument with solvents containing peroxides.
� Use the instrument for production purposes.

2.3 Staff qualification
Unqualified persons are unable to identify risks and are therefore exposed to greater
dangers.
The device may only be operated by suitably qualified laboratory staff.
These operating instructions are aimed at the following target groups:

Users
Users are persons that meet the following criteria:
� They have been instructed in the use of the device.
� They are familiar with the contents of these operating instructions and the

applicable safety regulations and apply them.
� They are able on the basis of their training or professional experience to assess

the risks associated with the use of the device.

Operator
The operator (generally the laboratory manager) is responsible for the following
aspects:
� The device must be correctly installed, commissioned, operated and serviced.
� Only suitably qualified staff may be assigned the task of performing the operations

described in these operating instructions.
� The staff must comply with the local applicable requirements and regulations for

safe and hazard-conscious working practices.
� Safety-related incidents that occur while using the device should be reported to the

manufacturer (quality@buchi.com).

BUCHI service technicians
Service technicians authorized by BUCHI have attended special training courses and
are authorized by BÜCHI Labortechnik AG to carry out special servicing and repair
measures.

2.4 Residual risks
The device has been developed and manufactured using the latest technological
advances. Nevertheless, risks to persons, property or the environment can arise if the
device is used incorrectly.
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Appropriate warnings in this manual serve to alert the user to these residual dangers.

2.4.1 Faults during operation
If a device is damaged, sharp edges, moving parts or exposed electrical wires can
cause injuries.
u Regularly check device for visible damage.
u If faults occur, switch off the device immediately, unplug the power cord and

inform the operator.
u Do not continue to use devices that are damaged.

2.4.2 Malware infection due to connections with other devices or
network
Connections with other devices or a network can cause a malware infection to the
instrument.
u Install antivirus software and firewall on the instrument before connecting it to

other devices or network.

2.4.3 Damage to the internal memory due to incorrect shutting
down of the instrument
Incorrect shutting down of the instrument can cause damage to the internal memory.
u Shut down the instrument as described. See Chapter 6 "Operation", page 24

2.5 Personal protective equipment
Depending on the application, hazards due to heat and/or corrosive chemicals may
arise.
u Always wear appropriate personal protective equipment such as safety goggles,

protective clothing and gloves.
u Make sure that the personal protective equipment meets the requirements of the

safety data sheets for all chemicals used.

2.6 Modifications
Unauthorized modifications can effect safety and lead to accidents.
u Use only genuine BUCHI accessories, spare parts and consumables.
u Carry out technical changes only with prior written approval from BUCHI.
u Only allow changes to be made by BUCHI service technicians.

BUCHI accepts no liability for damage, faults and malfunctions resulting from
unauthorized modifications.
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3 Product description

3.1 Description of function
The instrument is a purification device designed to purify complex samples by flash
chromatography.
� Flash chromatography has the ability to separate gram size samples in short

period.

The instrument allows:
� 2 different solvents
� Injection of liquid or solid sample
� Separation on a cartridge
� Identifying the compounds by UV
� Collecting the desired fractions

Instrument schematic:

G
radient valve

UV
detector

Fraction
collection

Solvent 2

Solvent 1

Pump

Sample
introduction

C
artridge



Büchi Labortechnik AG Product description | 3

Operation Manual Pure Chromatography Instrument C-805 11/72

3.2 Configuration
3.2.1 Front view

1

2 3 4

5

6

7

Fig. 1: Front view

1 Control panel 2 RFID reader
3 On/Off switch 4 USB Port
5 Cartridge holder 6 Flash pump
7 Fraction collection bay

3.2.2 Rear view
NOTE
All electrical connections are not limited energy.
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9

8

7
6

1 2

345

Fig. 2: Rear view

1 Ventilation slot 2 Gradient valve
(See Chapter 3.2.3 "Connections on
gradient valve", page 13 )

3 Signal connection
(for external air supply)

4 LAN port

5 Power supply connection 6 Fuse
7 On/Off master switch 8 USB ports
9 Type plate

(See Chapter 3.3 "Type plate",
page 13
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3.2.3 Connections on gradient valve

321

Fig. 3: Connections on the gradient valve

1 Waste line 2 Solvent line 2
3 Solvent line 1

3.3 Type plate
The type plate identifies the instrument. The type plate is located at the rear of the
instrument.

 

Buchi Labortechnik AG

9230 Flawil / Switzerland

Type:  xxx

SN:  10xxxxxxxx

Volt:  xxx-xxx VAC

Frequ.: xx Hz

Power: xxxx W

Built:  20xx

Made in Switzerland 

6

5

4

1

3

2

7

8 9 10 9

Fig. 4: Type Plate

1 Company name and address 2 Instrument name
3 Serial number 4 Input voltage range
5 Frequency 6 Power consumption maximum
7 Year of manufacture 8 Product code
9 Approvals 10 Symbol for "Do not dispose of as

household waste"
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3.4 Scope of delivery
NOTE
The scope of delivery depends of the configuration of the purchase order.

Accessories are delivered as per the purchase order, order confirmation, and
delivery note.

3.5 Technical data
3.5.1 Pure Chromatography Instrument C-805

Pure C-805
Dimension
(W x D x H)

365 x 570 x 680 mm

Weight 24 kg
Clearance on each side of the instrument 200 mm
Power consumption 350 W
Connection voltage 100 - 240 V ± 10 %
Frequency 50 - 60 Hz
Fuse 4 A
Overvoltage category II
Pollution degree 2
IP Code IP 20
Solvents 2
USB port 3
LAN port
(RJ45)

1

RFID reader
(racks)

Yes

RFID reader
(cartridges)

Yes

Fraction collector bay closed
Lighted fraction collector bay Yes
Vapor sensor Yes

Pump Flash Mode

Pure C-805
Gradient binary
Pressure range 0 - 50 bar
Flow rate 0 - 250 mL/min
Flow rate accuracy < 2 %
Functional principle self-priming
Specification 3 pistons

radial arranged

UV Detector

Pure C-805
UV wavelength range 200 - 400 nm
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Pure C-805
Light sources Deuterium
Lifetime lamp 2000 hours
Detector DAD

3.5.2 Ambient conditions
For indoor use only.

Max. altitude above sea level 2000 m
Ambient temperature 5‒40°C (25°C)

No maximum performance above 25°C
Maximum relative humidity 80% non-condensing, for temperatures up

to 31°C
Storage temperature max. 45 °C

3.5.3 Material
Component Materials of construction
Housing Powder coated steel 1.4301
Fraction collection bay PMMA / PET
Pump head PEEK
Pump cover PP
Pump excenter housing Aluminum
Tubings FEP
Fitting POM
Valve screw fitting POM
Ferrule ETFE
Cone ring POM
Radial seal PTFE
Pistons Ceramic
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4 Transport and storage

4.1 Transport
NOTICE

Risk of breakage due to incorrect transportation

u Make sure that all parts of the device are safely packed in such a way as to
prevent breakage, ideally in the original box.

u Avoid sharp movements during transit.

u After transportation, check the device for damage.
u Damage that has occurred in transit should be reported to the carrier.
u Keep packing for future transportation.

4.2 Storage
u Make sure that the ambient conditions are complied with (see Chapter 3.5

"Technical data", page 14).
u Make sure a clean solvent like ethanol or isopropanol is in the pump.
u Wherever possible, store the device in its original packaging.
u After storage, check the device, all seals and tubing for damage and replace if

necessary.
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4.3 Lifting the instrument
 WARNING

Danger due to incorrect transportation

The possible consequences are crushing injuries, cuts and breakages.

u The instrument should be transported by two persons at the same time.
u Lift the instrument at the points indicated.

u Lift the instrument – this requires two persons each lifting at one of the points
indicated on the bottom of the instrument.
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5 Installation

5.1 Installation site
The installation site must meet the following requirements:
� The installation site has a firm, level surface.
� The installation site meets the specifications according to the technical data (e.g.

weight, dimension, etc.). See Chapter 3.5 "Technical data", page 14
� The installation site has no obstacles (e.g. water taps, drains, etc.).
� The installation site is not exposed to external thermal loads, such as direct solar

radiation.
� The installation site has a own mains outlet socket for the instrument.
� The installation site has enough space that cables / tubes can be routed safely.
� The installation site allows that the power supply can be disconnected at any time

in an emergency.
� The installation site is not exposed to increased electromagnetic emissions.

Electromagnetic fields in the frequency range between 200 to 300 MHz can cause
the instrument to operate incorrectly.

� The installation site meets the requirements of the safety data sheets for all
solvents and samples used.

5.2 Before installation
NOTICE

Instrument damage due to switching it on too early.

Switching on the instrument too early after transportation can cause damage.

u Climatize the instrument after transportation.

5.3 Securing against earthquakes
The instrument has an earthquake fixing point to protect the device against falling.

1

Fig. 5: Securing against earthquakes

1 Fixing point

u Tie the lashing mount to a fixed point using strong cord or a wire.
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5.4 Establishing electrical connections
NOTICE

Risk of instrument damage because of not suitable power supply cables.

Not suitable power supply cables can cause bad performance or an instrument
damage

u Use only BUCHI power supply cables.

Precondition:
R The electrical installation is as specified on the

type plate.
R The electrical installation is equipped with a

proper grounding system.
R The electrical installation is equipped with

suitable fuses and electrical safety features.
R The installation site is as specified in the

technical date. See Chapter 3.5 "Technical
data", page 14

u Connect the power supply cable to the
connection on the instrument. See Chapter 3.2
"Configuration", page 11

u Connect the mains plug to an own mains outlet
socket.

5.5 Establishing solvent connection
NOTICE

Solvent bottles on top of the instrument.

Solvent bottles on top of the instrument can cause property damages.

u Locate the solvent bottles next to the instrument.
u Use the optional solvent bottle platform.

Precondition:
R Make sure that the instrument is not connected

to the power supply.
u Attach all solvent lines to the instrument.

Connections see Chapter 3.2 "Configuration",
page 11

u Put the other end of the solvent line into the
solvent bottle.

u Assign the solvent to the solvent lines. See
Chapter 5.6 "Assigning solvent to solvent lines",
page 20
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5.6 Assigning solvent to solvent lines

Navigation path

➔ Tools ➔ Solvent Loading

Precondition:
R The solvent bottle is connected to the instrument. See Establishing solvent

connection
R The solvent you wish to use is part of the solvent library. See Chapter 6.3 "Editing

a solvent", page 42

u Navigate to the Solvent Loading  dialog according to the navigation path.

ð The display shows the dialog box Solvent Loading .

u Tap the drop-down list next to Line 1.
ð The display shows a drop-down list with selectable solvents.
u Select the solvent which is connected to solvent line 1.
ð The solvent for Line 1 is assigned.
ð The drop-down list closes.
u Repeat the solvent selection for each line.
u Activate the checkbox next to the line you wish to prime.
u Tap the button [Auto Prime].
u Wait till priming finished.
u Tap the button [Close].
ð All lines are assigned with solvents.
ð The dialog box closes.

5.7 Assembling the waste bottle
NOTICE

Waste bottle on top of the instrument

Waste bottle on top of the instrument can cause property damages.

u Make sure that there is a decline between the connection on the instrument and
the waste bottle.
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u Put the waste line into the waste bottle.

5.8 Assembling the solvent bottle platform (option)
NOTICE

Waste bottle on top of the instrument

Waste bottle on top of the instrument can cause property damages.

u Do not place the waste bottle an the solvent bottle platform.

u Turn the solvent bottle platform upside down.

u Attach the drain line adapter to the solvent bottle
platform

u Attach the drain line to the drain line adapter.
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u Attach the solvent bottle platform to the
instrument with screws.

5.9 Assembling the cartridge holder
u Attach the bracket with screws to the

instrument.

u Assemble the cartridge clamp to the
rod.

u Fix the position of the clamp with the
screw.

u Attach the assembled cartridge clamp
to the bracket.
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u Place a washer and a serrated lock
washer on top and attach the cartridge
clamp with a screw.

ð The cartridge clamp is assembled.

u The cartridge clamp can be opened by
pressing simultaneously both parts
together.

In this position the cartridge can be
placed in the clamp.



6 | Operation Büchi Labortechnik AG

24/72 Operation Manual Pure Chromatography Instrument C-805

6 Operation

6.1 Control panel
6.1.1 Layout of control panel

5

9

8

7

1 2 3 4

6

Fig. 6: Display

No. Description Function
1 [Menu] bar Shows the available menus.

See Menu bar
2 [Conditions] panel Shows the properties and default settings

of the installed column / cartridge.
See Conditions panel

3 [Wavelength] panel Shows available wavelengths and scan
options.

4 [Collection] panel Shows collection options.
See Chapter 6.1.5 "Collection panel",
page 29

5 [Gradient] panel Shows chromatograms and gradient ta-
ble.
See Gradient panel

6 [Run] panel Shows the operation options.
See Chapter 6.1.7 "Run panel", page 31

7 [Solvent selection] panel Shows selectable solvents.
See Chapter 6.1.8 "Solvent selection
panel", page 32

8 [Detector settings] panel Shows selectable detector options and its
settings.
See Detector selection panel
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No. Description Function
9 [Slope detection] panel Shows selectable slope detection options.

See Chapter 6.1.10 "Slope detection
panel", page 33

6.1.2 Enter value
Enter numbers
u Tab on an entry field.

ð The display shows a dialog box with a numeric input box.
u Enter the value.
u Tap the button [OK].
ð The value is saved.
ð The dialog box closes.

Enter names
u Tab on an entry field.

ð The display shows a dialog with an alphanumeric input box.
u Enter the value.
u Tap the button [OK].
ð The value is saved.
ð The dialog box closes.

6.1.3 Menu bar
The following menus are available:
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Menu Submenu / Action Explanation
[File] [Open Method] Load an existing method.

See Chapter 6.4.4 "Selecting an existing
method", page 46

[Save Method] Save an edited method.
See Chapter 6.2.8 "Saving a method",
page 42

[Save Method as] Save an edited method with another
name.
See Chapter 6.2.8 "Saving a method",
page 42

[Open Run] Load a completed run.

[Print Run Report] See Chapter 6.8.1 "Printing a run report",
page 51

[Print PDF to USB] See Chapter 6.8.3 "Sending PDF to
USB", page 52

[Exit] Exit the Pure software to Windows® sys-
tem software.

[Shut down] The instrument shuts down.

[View] [Setup] If [Setup] is marked up, the instrument is
in setup mode.

[Run in Progress] If [Run in Progress] is marked, a run is
in progress.

[Past Run] If [Past Run] is marked up, the instru-
ment is in the past run mode.
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Menu Submenu / Action Explanation
[Tools] [Solvent Loading] Assign a solvent to a solvent line.

See Chapter 5.6 "Assigning solvent to sol-
vent lines", page 20

[Solvent Definition] Define solvents.
See Chapter 6.3 "Editing a solvent",
page 42

[Vapor Sensors and Lim-
its]

Edit the vapor sensor sensitivity.
See Chapter 6.2.7 "Editing the vapor sen-
sor sensitivity", page 41

[Configuration] System configurations.

[Calibration and Defaults] Calibrate the screen.
Set time and date.
Reset UV lamp.
Set alarms

[Manual control] Maintenance actions.
See Chapter 7.5 "Cleaning the instru-
ment", page 55
See Chapter 8.7 "Resetting the Fraction
collector arm", page 63

[NP<>RP] Change back and forth between normal
phase and reverse phase

[Product Services] Override max. pressure limit for car-
tridges.

[UV Baseline] Adjust the baseline to zero during a run.

[Language] Select a language.

[Service] BUCHI service technicians only

[Help] [About] The display shows instrument details.

[View Manual] The display shows the Operation manual.
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6.1.4 Conditions panel

1

1 Information button
(Information about the selected col-
umn)

The conditions area contains the following settings:

Action Option Explanation
[Column] Automatic via RFID Shows the name of the cartridge in-

stalled in the instrument.
[Flow Rate] Enter value Edit the default flow rate.

[Duration Units] Choice of the duration
type

The following types are available:
minutes / column volumes

[Equilibration] Enter value Indicates the period of time or num-
ber of column volumes that the mo-
bile phase flows through the column
before the sample is injected.

[Run Length] Enter value According to the current operation en-
ter the time for the separation.
According to the current operation en-
ter the number of column volumes re-
quired for the separation.
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6.1.5 Collection panel

1

1 Tray number

The collection vial matrix corresponds to the trays. The trays are detected by the auto
recognition. The estimated number of vials required for the separation is displayed
below the solvent usage list in the lower left corner of the Setup window.
The fraction collection area contains the following settings:

Action Option Explanation
Fraction collection
options

Select value The following options are available:
[Collect Peaks] / [Collect All] /
[Collect None]

[Per-Vial Volume] View / Enter value The following values are changeable:
[Peak] / [Non-Peaks]
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6.1.6 Gradient panel

Edit the gradient and see separation details.

NOTE
According to the instrument status different options are available.

Action Option Explanation
[Table] Create a gradient See Editing the gradient in tabular

mode
[Navigator] Finding out Flash sepa-

ration conditions
See Chapter 10.3 "Finding out sepa-
ration conditions with the navigator",
page 67

[UV scan details] View Shows the following charts:
� 3D (UV / Time/ Wavelength)
� 2D (Time / Wavelength)
� Absorption maxima
� All scan maxima

[Zoom] Function Zoom the graph.

[Options] Select values Graph options.

[Edit] Select between the op-
tions

The graph is in edit mode. See Edit-
ing the gradient in graphic mode

[View] The graph is in view mode.
(No changes possible)

[Zoom] Zoom the graph.

[Gradient hold] Function The gradient is held at the current
solvent ratio.
The gradient continues to the original
end-point.

[Auto gradient
hold]

Function The gradient will be held every time
the signal goes over the set thresh-
old.
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6.1.7 Run panel

The run panel shows available functions according to the current operation.

Symbol Description Meaning
[Start] Is used to start the run or re-start the

actual operation if the system has
been paused.

[Stop] Is used to terminate the operation of
the system.

[Pause] Is used to stop the actual operation.
If the system is paused due to an er-
ror, this button will change to yellow.

[Advance] Is used to advance to the next step
during equilibration.
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6.1.8 Solvent selection panel

Select solvents for a separation. See Chapter 6.2.2 "Selecting a solvent", page 35

6.1.9 Detector selection panel

Action Option Explanation
[UV] Enable / Disable

Select value / Enter
value

Action enabled:
Low / High
Enter values for threshold
Action disabled:
No selection

[Threshold Detec-
tion]

Enter value The threshold defines the value
above the fraction collector starts to
collect fractions.
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6.1.10 Slope detection panel

Action Option Explanation
[Slope detection] Enable / Disable Action enabled:

Fraction collection triggered by slope
Action disabled:
No detection

6.2 Editing a method
6.2.1 Selecting a cartridge (Flash mode)

NOTE
The automatic reading of the cartridge information can only be done with specific
BUCHI RFID tagged cartridges.

u The indication for recognizing the cartridge is a sound.
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1

1 Information button
(Information about the selected col-
umn)

Navigation path

➔ Conditions panel

u Navigate to the Condit ions selection  panel according the navigation path.
u Tap the input box next to [Column].
ð The display shows a menu with selectable cartridges.
u Select the cartridges you wish to use.



Büchi Labortechnik AG Operation | 6

Operation Manual Pure Chromatography Instrument C-805 35/72

6.2.2 Selecting a solvent

Navigation path

➔ Solvent selection panel

Precondition:
R The required solvents lines are connected and assigned. See Chapter 5.6

"Assigning solvent to solvent lines", page 20

u Navigate to the Solvent select ion  panel according the navigation path.
u Tap the drop-down list next to A: .
ð The display shows a drop-down list with the assigned solvents.
u Tap the required solvent.
ð The solvent is selected
ð The drop-down list closes.
u Select more solvents for the mobile phase according to your needs.

6.2.3 Editing the gradient
The composition of the mobile phase as a function of time can be indicated by
entering the gradient. Solvent lines can be used to generate a binary gradient.
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Editing the gradient in tabular mode

The following settings are available:

Action Option Explanation
[Min] Enter value Enter the time until the value in col-

umn [% 2nd] is reached.
[Solvents] Select value Select solvent line combinations.

[% 2nd] Enter value Enter the percentage rate for the sec-
ond solvent.

Navigation path

➔ Gradient panel

u Navigate to the Gradient  panel according the navigation path.
u Tap the button [Table].

ð The display shows the dialog Gradient Table .

u Tap the cell for [Min].
ð The display shows a dialog box with a numeric input box.
u Enter the time.
u Tap the button [OK].
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u Tap the cell for [% 2nd].
ð The display shows a dialog box with a numeric input box.
u Enter the percentage for the second solvent.
u Tap the button [OK].
u Tap the button [Close].
ð The gradient is saved
ð The dialog Gradient table closes

ð The Gradient  panel shows the set gradient.

Add additional lines to the Gradient table
u Tap the number field (e.g. 1►).
ð The display shows a drop-down list with selectable actions.
u Select if the line should be added above or below the selected line.
ð A line is added.

Deleting lines from the Gradient table
u Tap the number field (e.g. 1►).
ð The display shows a drop-down list with selectable actions.
u Select delete.
ð The line is deleted.

Editing the gradient in graphic mode
Navigation path

➔ Gradient panel

u Navigate to the Gradient  panel according the navigation path.
u Tap the button [Edit].
ð The Display shows a drop-down list.
u Select [Edit].

Add steps to the Gradient graphic
u Tap on the line at the time for which you want to edit the gradient and drag it to the

desired %B, then release.

Deleting steps from the Gradient graphic
u To remove a step, drag the point to the baseline or to any gray area around the

graph until a red X is visible, then release.
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6.2.4 Editing the wavelength for the UV detector

Status Checkbox Explanation Explanation
On The instrument collects fractions.

Monitoring The instrument records the data from the
UV detector but does not collect the frac-
tions.

Off The instrument does not record data from
the UV detector and does not collect frac-
tions.

Navigation path

➔ Wavelength selection panel

Precondition:
R The UV detector is selected.

u Navigate to the Wavelength  panel according the navigation path.
u Activate the checkbock next to [UV].
u Tap the input box next to [UV].
ð The display shows a dialog box with a numeric input box.
u Enter a value for the wavelength.
u Tap the button [OK].
ð The dialog box closes.
ð The wavelength is saved.
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6.2.5 Editing the fraction collection criteria

1

1 Identifier

The following fraction collection criteria are available:

Criteria Meaning
[Collect Peaks] The instrument collects fractions if one detector signal is

above the set threshold.
[Collect All] The instrument collects all the fractions regardless of de-

tection signals.
[Collect None] The instrument collects no fractions.

NOTE
[Peak] and [Non-Peaks] default is the maximum volume of the vial.

Navigation path

➔ Collection panel

u Tap the radio button next to criteria you wish to use.
ð The criteria is selected.
u Tap the input box next to [Peak].
ð The display shows a dialog box with a numeric input box.
u Enter a the volume you wish to collect.
u Tap the button [OK].
ð The dialog box closes.
ð The value for the volume is saved.
u Tap the input box next to [Non-Peaks].
ð The display shows a dialog box with a numeric input box.
u Enter the volume you wish to collect.
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u Tap the button [OK].
ð The dialog box closes.

6.2.6 Editing the fraction collection time

Program Collect allows to turn off fraction collection for a specific time.
The fraction collector defaults to collect the full run length unless the values from
Program Collect override the collection.

Navigation path

➔ Gradient panel

u Navigate to the Gradient  panel according the navigation path.
u Tap the button [Program collect].

ð The display shows the dialog Program col lect .
u Tap the input box.
ð The display shows a dialog box with a numeric input box.
u Enter the time.
u Tap the button [OK].
ð The time is saved.
ð The dialog box closes.
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Add additional lines to the program collection
u Tap the number field (1►).
ð The display shows a drop-down list with selectable actions.
u Select if the line should be added above or below the selected line.
ð A line is added.

Deleting lines from the program collection
u Tap the number field (1►).
ð The display shows a drop-down list with selectable actions.
u Select delete.
ð The line is deleted.

6.2.7 Editing the vapor sensor sensitivity

The vapor sensor detects solvent concentration in the ambient air.
The following sensitivity limits are available:

Sensitivity Meaning
High Used for non-volatile solvents
Medium Compromise between the low and high setting
Low Used for volatile or semi-volatile solvents
Off The vapor sensor is off

Navigation path

➔ Tools ➔ Vapor Sensor and Limits

u Navigate to the Vapor Sensors  dialog according to the navigation path.

ð The display shows the dialog box Vapor Sensors .

u Tap the drop-down list next [Vapor alarm sensitivity].
u Select the sensitivity value you wish to use.
u Tap the button [Close].
ð The dialog box closes.
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6.2.8 Saving a method

Navigation path

➔ File ➔ Save Method as

u Navigate to the Save Method as  dialog according to the navigation path.

ð The display shows the dialog box Save Method as .

u Tap the input box [Enter method name].
ð The display shows a dialog with an alphanumeric input box.
u Enter the name of the method.
u Tap the button [OK].
ð The dialog box closes.
u Tap the button [OK].
ð The method is saved.
ð The dialog box closes.

6.3 Editing a solvent
6.3.1 Adding a new solvent

Navigation path

➔ Tools ➔ Solvent Definition

u Navigate to the Solvent Definit ion  dialog according to the navigation path.

ð The display shows the dialog box Solvent Definit ion .

u Tap the button [Add Solvent].

ð The display shows the dialog box Solvent .
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u Tap the input box next to [Name].
ð The display shows a dialog with an alphanumeric input box.
u Enter the name for the solvent.
u Tap the button [OK].
ð The dialog box closes.
u Tap the input box next to [Info].
ð The display shows a dialog with an alphanumeric input box.
u Enter information to the solvent according to your requirements.
u Tap the button [OK].
ð The dialog box closes.
u Tap the button [Verify Solvents].

ð The display shows the dialog box Solvent Verif icat ion .

u Select solvent group for the defined solvent.
u Tap the button [OK].
ð The dialog box closes.
ð The solvent is added.
u Tap the button [Close].

ð The dialog box Solvent Definit ion  closes.

6.3.2 Deleting a solvent

Navigation path

➔ Tools ➔ Solvent Definition

u Navigate to the Solvent Definit ion  dialog according to the navigation path.

ð The display shows the dialog box Solvent Definit ion .

u Select the solvent you wish to delete.
u Tap the button [Delete Solvent].
u Answer the secure question with [Yes].
ð The solvent is deleted.
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6.4 Tasks during a separation
6.4.1 Injecting a sample into the flash system

Injecting a sample into the cartridge
u Remove the solvent line from the cartridge.

u Connect the syringe to the cartridge.

u Press the plunger.

u Disconnect the syringe.
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u Connect the solvent line.

6.4.2 Installing and removing a cartridge
NOTE
Removing is done in reverse sequence.

NOTE
Instead of a cartridge a bypass can be installed.

NOTE
The automatic reading of the cartridge information can only be done with specific
BUCHI RFID tagged cartridges.

u The indication for recognizing the cartridge is a sound.

u Open the solvent line at the point indicated.

u Hold the cartridge above the RFID reader.
u Wait until the instrument has taken over the

cartridge data.

u Attach the cartridge to the cartridge holder.
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u Attach the solvent lines to the cartridge.

6.4.3 Inserting the fraction collection tray
NOTE
By default the first available tube on each tray is reserved for waste.

Changing the setting. See Chapter 6.4.5 "Selecting values on the dialog box Sample
Loading", page 47

1 2

1 Tab 2 Optical sensor slot

u Place the collection tubes in the collection tray.
u Place the trays in the fraction collector bay.
u Make sure that the tab is in the optical sensor slot.

6.4.4 Selecting an existing method
Navigation path

➔ File ➔ Open Method

u Navigate to the Open Method  dialog according to the navigation path.

ð The display shows the dialog box Open Method .

u Select the method you wish to use.
u The display highlights the selected method black.
u Tap the button [OK].
ð The method is selected.
ð The dialog box closes.
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6.4.5 Selecting values on the dialog box Sample Loading
The display shows the dialog box Sample Loading  during the starting phase of a
separation.
The following settings are possible:

Action Explanation
[Lower flow rate for
specified time after in-
jection]

Reduce flow rate for a specified period, when the pressure
increases significantly at the start of the run after sample
injection.

[Flush 2nd solvent at
the end of the run]

Automatically cleaning the system and column.

[Override Start Vial] Select the start vial according to your needs.

6.5 Performing a Flash separation using a method
6.5.1 Preparing the instrument

Time required: approx. 30 sec.

Precondition:
R All commissioning operations have been completed. See Chapter 5 "Installation",

page 18
u Switch the On/Off master switch to On.
u Tap the On/Off switch.
ð The instrument is starting up.

6.5.2 Starting Flash separation using a method
Precondition:
R The instrument is prepared. See Chapter 6.5.1 "Preparing the instrument",

page 47
R The required solvents are connected and assigned. See Chapter 5.6 "Assigning

solvent to solvent lines", page 20
R The sample is prepared.
R The waste bottle is empty.
u Open the protection shield.
u Place the fraction collection trays inside the instrument. See Chapter 6.4.3

"Inserting the fraction collection tray", page 46
u Close the protection shield.
u Open an existing method. See Chapter 6.4.4 "Selecting an existing method",

page 46
u Tap the button [OK].
u Tap the button [Start] on the Run  panel.
u According the requirements adjust the file name.
u Tap the button [OK].

ð The display shows the dialog box Sample Loading .

u According the requirements adjust the settings. See Chapter 6.4.5 "Selecting
values on the dialog box Sample Loading", page 47
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u Follow the instructions on the display.
ð Installing the cartridge. See Chapter 6.4.2 "Installing and removing a cartridge",

page 45
ð Introducing the sample into the system. See Chapter 6.4.1 "Injecting a sample

into the flash system", page 44

6.5.3 Changings during a separation
NOTE
Parameters that can be edited are highlighted in green

Possibilities to edit the gradient during a separation:
� Change the gradient. See Editing the gradient in graphic mode
� Hold the gradient. See Gradient panel
� Auto gradient hold. See Gradient panel

6.5.4 Ending a Flash separation
NOTE
The separation extends automatically by 5 minutes if the baseline at the end of the
separation is not below the set threshold.

Precondition:
R The display shows the dialog box Separation End .

u According to the requirements extend the separation time by 5 minutes.

Precondition:
R The display shows the dialog box Run completed .

u Follow the instructions on the display.
ð Removing the cartridge. See Installing and removing a cartridge

6.5.5 Shutting down the instrument
Navigation path

➔ File

Precondition:
R The separation process has ended.
u Purge the instrument with purging solvent. See Chapter 7.5 "Cleaning the

instrument", page 55
u Navigate to the [File] menu via the navigation path.
u Tap the action [Shut down].
u Confirm the secure question with [Yes].
ð The instrument is shutting down.

6.6 Performing a Flash separation manually
6.6.1 Preparing the instrument

Time required: approx. 30 sec.

Precondition:
R All commissioning operations have been completed. See Chapter 5 "Installation",

page 18
u Switch the On/Off master switch to On.
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u Tap the On/Off switch.
ð The instrument is starting up.

6.6.2 Starting Flash separation manually
Precondition:
R The instrument is prepared. See Chapter 6.6.1 "Preparing the instrument",

page 48
R The required solvents are connected and assigned. See Chapter 5.6 "Assigning

solvent to solvent lines", page 20
R The sample is prepared.
R The waste bottle is empty.
u Open the protection shield.
u Place the fraction collection trays inside the instrument. See Chapter 6.4.3

"Inserting the fraction collection tray", page 46
u Close the protection shield.
u Select a cartridge. See Chapter 6.2.1 "Selecting a cartridge (Flash mode)",

page 33
u Tap the drop-down list next to A: on the Solvent Selection  panel.

ð The display shows a drop-down list with the assigned solvents.
u Tap the required solvent.
ð The solvent is selected
ð The drop-down list closes.
u Select more solvents for the mobile phase according to your needs.
u Edit the gradient according to your needs. See Chapter 6.2.3 "Editing the

gradient", page 35
u Select the sample collection in the Collect ion  panel. See Chapter 6.2.5 "Editing

the fraction collection criteria", page 39
u Select the collection criteria in the Collect ion cri teria  panel.

u Tap the button [Start] on the Run  panel.

ð The display shows the dialog box Sample Loading .

u According the requirements adjust the settings. See Chapter 6.4.5 "Selecting
values on the dialog box Sample Loading", page 47

u Follow the instructions on the display.
ð Installing the cartridge. See Installing and Removing a cartridge
ð Introducing the sample into the system. See Chapter 6.4.1 "Injecting a sample

into the flash system", page 44

6.6.3 Changings during a separation
NOTE
Parameters that can be edited are highlighted in green

Possibilities to edit the gradient during a separation:
� Change the gradient. See Editing the gradient in graphic mode
� Hold the gradient. See Gradient panel
� Auto gradient hold. See Gradient panel
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6.6.4 Ending a Flash separation
NOTE
The separation extends automatically by 5 minutes if the baseline at the end of the
separation is not below the set threshold.

Precondition:
R The display shows the dialog box Separation End .

u According to the requirements extend the separation time by 5 minutes.

Precondition:
R The display shows the dialog box Run completed .

u Follow the instructions on the display.
ð Removing the cartridge. See Installing and removing a cartridge

6.6.5 Shutting down the instrument
Navigation path

➔ File

Precondition:
R The separation process has ended.
u Purge the instrument with purging solvent. See Chapter 7.5 "Cleaning the

instrument", page 55
u Navigate to the [File] menu via the navigation path.
u Tap the action [Shut down].
u Confirm the secure question with [Yes].
ð The instrument is shutting down.

6.7 Identifying fractions
6.7.1 Identifying fractions by peak

Fig. 7: Identifying fractions
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Navigation path

➔ Gradient panel

Precondition:
R A separation is finished.

u Navigate to the Gradient  panel according the navigation path.
u Tap the peak with the target value.

ð The Collect ion  panel shows the corresponding vial.

6.7.2 Identifying fractions per vial

Fig. 8: Identifying fractions

Navigation path

➔ Collection panel

Precondition:
R A separation is finished.

u Navigate to the Collect ion  panel according the navigation path.
u Tap the target vial.

ð The Gradient  panel shows the corresponding peak.

6.8 Importing and exporting data
6.8.1 Printing a run report

Navigation path

➔ File ➔ Print Run Report

Precondition:
R The instrument is in past run mode.

u Navigate to the Print Run Report  dialog according to the navigation path.

ð The display shows the Windows® print dialog.
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u Select your printer.
u Tap the button [OK].
ð The report is printed.

6.8.2 Sending data to USB
Navigation path

➔ Run panel

Precondition:
R The instrument is in past run mode.
u Connect a USB storage device to the instrument.
u Navigate to the Run  panel according the navigation path.
u Tap the button [Data to USB].
ð The instrument saves an Excel file to the USB storage device.
u Confirm the complete message.
ð The data is stored.

6.8.3 Sending PDF to USB
Navigation path

➔ Run panel

Precondition:
R The instrument is in past run mode.
u Connect a USB storage device to the instrument.
u Navigate to the Run  panel according the navigation path.
u Tap the button [PDF to USB].
ð The instrument saves a PDF file to the USB storage device.
u Confirm the complete message.
ð The data is saved.
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7 Cleaning and servicing
NOTE
Users may only carry out the servicing and cleaning operations described in this
section.

Any servicing and repair work which involves opening up the casing may only be
carried out by BUCHI service technicians.

u Use only genuine BUCHI consumables and spare parts in order to ensure correct
operation of the device and preserve the warranty.

7.1 Regular maintenance work
Component Action Frequency
Pumps and valves u Purge the instrument with purging solvent.

See Chapter 7.5 "Cleaning the instrument",
page 55

Daily

Tubing u Check for leaks. If a leak is observed,
resolve the issue before continuing.

Daily

Fittings u Inspect fittings; if solid material is deposited
on a fitting, clean and tighten (replace) the
fitting before continuing.

Daily

Drain lines u Check all drain lines to ensure that liquid
can flow through them to the waste
container

Daily

Waste bottle u Empty the waste bottle Daily
Cartridge holder u Check the holding capability of the cartridge

holder.
u Check if the screws are tightened.

Weekly

Filters u Check the filters in the solvent bottles and
clean if necessary.

Weekly

Fittings u Check and if necessary tighten the fitting
that secures the tubing from the mobile
phase reservoir manifold to the inlet check
valve housing

Weekly

Data u Perform a data backup Weekly
Casing u Wipe down the casing with a damp cloth.

u If heavily soiled, use ethanol or a mild
detergent.

Weekly

Warning symbols u Check that the warning symbols on the
instrument are legible.

u If they are dirty, clean them.

Weekly

Display u Wipe down the display with a damp cloth. Monthly
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7.2 Carrying out a data backup

Navigation path

➔ File ➔ Exit

u Navigate to the Exit  dialog according to the navigation path.
u Confirm the secure question.
ð The Pure software is shutting down.
ð The display shows a Windows® system.
u Connect a USB storage device to the instrument.
u Open the Windows® Explorer.
u Navigate to the data you wish to backup. See Chapter 10.2 "Folder locations",

page 67
u Copy the needed data to the USB storage devices.

7.3 Calibrating the display
Navigation path

➔ Tools ➔ Calibration and Defaults

u Navigate to the Calibrat ion and Defaults  dialog according to the navigation
path.

u Tap the button [Calibrate].
u Follow the instructions on the display.

7.4 Cleaning the check valve
NOTE
Most check valve problems can be solved by pumping a strong solution of liquid
laboratory grade detergent through the check valves at a rate of 20 mL/min for one
hour.
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Pumping detergent through the check valves
Materials needed:
� Liquid Laboratory Detergent
� Isopropanol/Water (50/50) or Methanol/Water (50/50)

Navigation path

➔ Tools ➔ Manual Control ➔ Column Flushing...

Precondition:
R A bypass is installed. See Installing and removing a column

u Navigate to the Column Flushing  dialog according to the navigation path.

Sonicate the check valve
Materials needed:
� Open-end wrench, ½”, 9/16" x 5/16"
� Torque wrench

u Switch the On/Off master switch to Off.
u Disconnect the mobile phase tubing from the inlet (bottom) of the pump head

using the 9/16” open-end wrench.
u Disconnect the mobile phase outlet tubing from the top of the pump head using

the 5/16” open end wrench.
u Remove both check valve housings from the pump head using the ½” open-end

wrench.
ð The check valve capsule is accessible.
u Sonicating the check valve for 10 min in the appropriate solvent.
u Install the check valve.
u Install the check valve housings back into the pump head.
u Tighten the check valve housing to 75 inch pounds with the ½” torque wrench.

7.5 Cleaning the instrument

Navigation path

➔ Tools ➔ Manual Control ➔ Column Flushing...

Precondition:
R A purging solvent is assigned to the instrument. See Chapter 5.6 "Assigning

solvent to solvent lines", page 20
u Install a bypass. See Installing and removing a column
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u Navigate to the Column Flushing  dialog according to the navigation path.
u Enter the required data according to your needs.
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8 Help with faults

8.1 Faults, possible causes and solutions (general)
Malfunction Possible cause Solution
The instrument does
not power up

Power is not being supplied to
the system

u Verify that the power cord is
plugged in.

u Make sure that the voltage,
amperage and frequency
meet the instrument
specifications.

u Make sure that both power
switches are switched on.

u Verify that the fuse wire is
not broken and fuses are
correctly installed in the
instrument.

System shuts down
automatically

Major fluctuations in line power
are present

u Connect system to a
Uninterrupted Power Supply
line.

The touch screen is
not responsive

The touch screen is out of cali-
bration

u Recalibrate the touch
screen.

8.2 Faults, possible causes and solutions (cartridge)
Malfunction Possible cause Solution
Cartridge is not de-
tected

RFID tag is not facing the RFID
reader

u Turn cartridge so that RFID
tag faces RFID reader.

RFID tag is bad u Use new cartridge.

8.3 Faults, possible causes and solutions (solvent delivery)
Malfunction Possible cause Solution
No solvent flow Empty solvent bottle u Refill the solvent bottle.

Pump not primed u Prime the pump.
u Remove the check valve and

clean it by sonicating the
check valve in IPA.

u If sonication does not work
replace the check valve with
a new check valve.

Air bubbles in solvent line u Prime the pump.
Pump seals worn out u Replace the pump seals.

Pulsation of pump Open or close time of the inlet
or outlet valves are not correct

u Rinse the pump module with
high flowrate with ethanol or
hot distilled water.

u Change check valves.
Residues in solvent
Sealing abrasion outlet valve
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Malfunction Possible cause Solution
Inconsistent solvent
flow

Loose fitting/air leak into the
pump

u Find the loose fitting
between mobile phase
reservoir manifold and pump
inlet fitting and tighten it up.

Liquid leak/pump seals worn
out

u Fix the leak/replace the
pump seals.

Pump head temperature
reaches solvent boiling temper-
ature, causing the pump to lose
prime and stop flow (this is
likely to occur when running
methods with highly volatile
solvents such as diethyl ether
and methylene chloride)

u Premix the solvents to
reduce solvent volatility.

u Place the highly volatile
solvent bottle in an ice bath
to eliminate boiling.

System pump pres-
sure is higher than
expected

Blocked solvent lines u Find the blocked lines and
replace it.

Over-tightened fitting u Loosen the fitting or replace
it.

Blocked columns or fluidic path u Locate the component that
caused the blockage, repair,
or replace the component.

Leaks Fitting connection not tight u Find the loose fitting and
tighten it up.

Damaged solvent line u Find the damaged solvent
line and replace it.

Pump not running Pump sensor cable becomes
disconnected

u Locate the cable and
reconnect to the pump
sensor.

Pump power cable becomes
disconnected

u Locate the power cable and
reconnect to the main board
or to the pump.

Incorrect flow path Incorrect fluidic connections to/
from the mode switching valve

u Check/correct the fluidic
connections.

8.4 Faults, possible causes and solutions (fraction
collection)
Malfunction Possible cause Solution
Liquid not being col-
lected in fraction
tubes

Incorrect fraction collection set-
tings

u Verify that fraction collection
information is set properly.

Liquid not centered
in fraction tube

Fraction collector is not cali-
brated

u Recalibrate the fraction
collector.

Fraction collector
(FC) arm does not
move

Fraction collector arm did not
home properly

u Reset the Fraction collector
arm.

Fraction collector arm motor is
slipping

u Tighten the motor coupler.

Fraction collector arm is ob-
structed

u Check for cable or burr in the
fraction collector arm path
and remove any obstruction.
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Malfunction Possible cause Solution
Tray not detected RFID tag is bad u Put another tray into the

same position to see if it is
recognized to confirm the
cause.

u Replace RFID tag.

8.5 Faults, possible causes and solutions (detection)
Malfunction Possible cause Solution
No UV signal UV light burned out u Replace the UV light.
Low UV signal Dirty flow cell u Clean the flow cell.

8.6 Error messages
Error message Possible cause Solution
Instrument Alarm:
Solvent pump:
Communication to
the pump cannot
be established.

Serial communication dis-
turbed

u Restart the instrument.

Instrument Alarm:
Solvent pump:
Motor overloading.

- u Contact BUCHI Customer
Service.

Instrument Alarm:
Solvent pump:
Motor regulation
error.

Hardware error solvent
pump

u Contact BUCHI Customer
Service.

Instrument Alarm:
Solvent pump:
Power supply er-
ror.

Hardware error solvent
pump

u Contact BUCHI Customer
Service.

Instrument Alarm:
Solvent pump:
Solvent pump mo-
tor fan is not work-
ing.

Hardware error fan solvent
pump

u Contact BUCHI Customer
Service.

Instrument Alarm:
UV detector: Com-
munication error
occurred.

Serial communication dis-
turbed

u Restart the instrument.

Instrument Alarm:
UV detector: Bad
block of High Volt-
age (HV) genera-
tor for lamp or dis-
connected lamp or
bad lamp.

Lamp defect u Check the lamp and restart
instrument.

u Contact BUCHI Customer
Service.

No lamp
Hardware error UV detector

https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
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Error message Possible cause Solution
Instrument Alarm:
UV detector: Bad
power supply of
lamp heater volt-
age.

Hardware error UV detector u Contact BUCHI Customer
Service.

Instrument Alarm:
UV detector: Bad
power supply of
lamp anodic volt-
age.

Hardware error UV detector u Contact BUCHI Customer
Service.

Instrument Alarm:
UV detector: Bad
power supply of
detector analog or
digital voltage.

Hardware error UV detector u Contact BUCHI Customer
Service.

Instrument Alarm:
UV detector: 4th
cycle of lamp igni-
tion fails.

Lamp defect u Check the lamp and restart
instrument.

Instrument Alarm:
UV detector: Lamp
spontaneously
douse during unit
working.

Lamp defect u Check the lamp and restart
instrument.

Instrument Alarm:
UV detector: Lamp
ignition fails after
short douse in AU-
TOZERO function
and repeated High
Voltage impulse
and heater cycle
fails too.

Hardware error UV detector. u Contact BUCHI Customer
Service.

Instrument Alarm:
UV detector: Bad
identification of
light peak caused
by low light inten-
sity.

Lamp defective/ Flow cell
dirty

u Check the lamp and restart
instrument.

Instrument Alarm:
UV detector: Bad
identification of
light peak caused
by unworkable
light intensity.

Lamp defective/ Flow cell
dirty

u Check the lamp and restart
instrument.

https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
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Error message Possible cause Solution
Instrument Alarm:
UV detector: Low
light intensity was
found on some
photo elements of
CCD sensor.

Hardware error UV detector u Contact BUCHI Customer
Service.

Instrument Alarm:
UV detector:
Spontaneously
failure on analog
or digital power
supply.

Hardware error UV detector u Contact BUCHI Customer
Service.

Instrument Alarm:
UV detector: Error
or base offset of
unit, bad CCD
sensor, monochro-
mator is open.

Hardware error UV detector u Contact BUCHI Customer
Service.

Instrument Alarm:
UV detector: Sec-
ondary lamp is not
working or lamp
spontaneously
douse.

2nd lamp defect u Check the lamp and restart
instrument.

Instrument Alarm:
UV detector: Any
fan is not working
or any fan is dis-
connected or me-
chanical blocked.

Hardware error UV detector u Contact BUCHI Customer
Service.

Solvent List File Solvent list file corrupted u Shutdown the Pure software.
u Delete the solvent list.
u Restart the Pure software.

Solvent Lines File:
Invalid program
execution.

Solvent lines file corrupted u Shutdown the Pure software.
u Delete the solvent list.
u Restart the Pure software.

Solvent Defaults
File: The solvent
information file
and the default
solvent informa-
tion file are miss-
ing.

Software damaged u Uninstall and reinstall
software.

Using Default Sol-
vent List: System
defaults used in-
stead of actual re-
source.

Solvent file has been
deleted

u Restart the instrument.

https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
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Error message Possible cause Solution
Solvent Pressure:
Pressure limit has
been exceeded.

Blockage in the line u Remove column.
u Replace with bypass.
u Determine if column is not

the source of blockage.
u If not column is the source of

blockage, then check all
fluidic lines.

Sample crashing/precipitate u Purge lines/system with a
strong or appropriate solvent
that will dissolve the sample

Valve stuck in incorrect po-
sition

u Reset valve position.
u Contact BUCHI Customer

Service.
Error in solvent
line calibration file.

Calibration file of solvent
lines damaged

u Shutdown the Pure software.
u Delete the calibration list.
u Restart the Pure software.

Sensor pressure
calibration file

Pressure sensor calibration
file damaged.

u Shutdown the Pure software.
u Delete the pressure value

list.
u Restart the Pure software.

Instrument Alarm:
Vapor

Vapor sensor settings are
set too sensitive

u Change the vapor limits to a
lower sensitivity. See
Chapter 6.2.7 "Editing the
vapor sensor sensitivity",
page 41

Leaks u Check for any leaks in the
solvent flow paths.

Solvent vapors in work area u Solvent vapors in the work
area may set on the alarm.
Use the instrument in a hood
or well ventilated area with
no open solvents near the
system.

Vapor sensor no
signal

Vapor sensor is not con-
nected or is defect

u Check the cable to the vapor
sensor.

Instrument Alarm:
Watchdog

Timing/communication issue
in software

If in setup mode:
u Restart the instrument.
u

If in run mode:
u Press reset.
u Restart after the run is finish.

Solvent Pressure Solvent pressure limit has
been exceeded

u Remove column.
u Replace with bypass.
u Determine if column is not

the source of blockage.
u If not column is the source of

blockage, then check all
fluidic lines.

https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
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Error message Possible cause Solution
Fraction Collector Arm is obstructed u Check arm path to make

sure there are no
obstructions.

u Reset the Fraction Collector
arm. See Chapter 8.7
"Resetting the Fraction
collector arm", page 63

Fraction collector arm did
not home properly

u Tighten the motor coupler.
u Contact BUCHI Customer

Service.
Fraction collector arm motor
is slipping

u Contact BUCHI Customer
Service.

Home position sensor is bad u Contact BUCHI Customer
Service.

Fraction collector arm motor
has no power

u Contact BUCHI Customer
Service.

Low Disk Space The disk space on this unit
is almost full.

u Back up and delete data.
u Contact BUCHI Customer

Service.

8.7 Resetting the Fraction collector arm
Navigation path

➔ Tools ➔ Manual Control ➔ Fraction Collector Arm Reset

u Navigate to the Fraction Collector Arm Reset  dialog according to the
navigation path.

u Confirm the secure question.
ð The Fraction collector arm is resetted.

https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
https://www.buchi.com/ch-de/contact
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9 Taking out of service and disposal

9.1 Taking out of service
u Switch off the instrument and disconnect it from the mains power supply.
u Remove all tubing and communication cables from the device.

9.2 Disposal
The operator is responsible for proper disposal of the instrument.
u When disposing of equipment observe the local regulations and statutory

requirements regarding waste disposal.
u When disposing, observe the disposal regulations of the materials used. Materials

used see Chapter 3.5 "Technical data", page 14

9.3 Returning the instrument
Before returning the instrument, contact the BÜCHI Labortechnik AG Service
Department.
https://www.buchi.com/contact

https://www.buchi.com/contact
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10 Appendix

10.1 Spare parts and accessories
Use only genuine BUCHI consumables and spare parts in order to ensure correct,
safe and reliable operation of the system.

NOTE
Any modifications of spare parts or assemblies are only allowed with the prior written
permission of BUCHI.

10.1.1 Accessories
Order no. Image

Pure rack type 1
Metal rack for 12 x 75 mm glass tubes, 1 pc.

11066672

Pure rack type 2
Metal rack for 13 x 100 mm glass tubes, 1 pc.

11066673

Pure rack type 3
Metal rack for 16 x 125 mm glass tubes, 1 pc.

11066674

Pure rack type 4
Metal rack for 16 x 150 mm glass tubes, 1 pc.

11066675

Pure rack type 5
Metal rack for 18 x 150 mm glass tubes, 1 pc.

11066676

Pure rack type 6
Metal rack for 25 x 150 mm glass tubes, 1 pc.

11066677

Pure rack type 7
Metal rack for 9 squared bottles of 480 mL, 1 pc.

11068452

Pure rack type 8 (funnel rack)
Metal rack for 6 funnels

11069407

Pure rack type 9
Metal rack for 16 x 100 mm glass tubes, 1 pc.

11069242
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Order no. Image
Solvent bottle platform kit
Solvent bottle platform on top of the instrument. For
maximum 4 bottles (volume 4 L each)

11069285

Retaining container
Retaining container for solvent bottle platform for more
safety regarding leaking

11068468

Loading Pump
with flow rates from 2.5 to 250 mL/min, incl. tubing and
fitting

11071418

10.1.2 Spare parts
Order no. Image

Touch-screen stylus 11068360

Pure Clamp for Pure Essential Cartridge Stand
Universal cartridge holder

11074604

Solvent line set
Set with 2 solvent level lines, ferrule, fitting and
adapters

11071873

10.1.3 Tools and adapter kits
Order no.

Luer lock connection set
Set of 2 luer lock adapters

11068242

Advanced adapter kit flash
Tube cutter, Fittings (1/8", 1/16"), Tubing (pneumatic, FEP 1/8", FEP 1/16"),
Luer Lock adapters, Pneumatic reduction, Fuses, Injection valve

11068361

10.1.4 Tubes
Order no.

Pure Glass Tubes 13 x 100 mm
1000 pcs.

148623414

Pure Glass Tubes 16 x 150 mm
1000 pcs.

148623416

Pure Glass Tubes 18 x 150 mm
500 pcs.

148623410

Pure Glass Tubes 25 x 150 mm
500 pcs.

148623411

Pure Squared bottles 480 mL
24 pcs.

148623412
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10.1.5 Wear parts
Order no. Image

Pure UV flow cell 0.3 mm
For all C-8xx

11068210

Pure UV flow cell 1.3 mm
For all C-8xx, for enhanced sensitivity

11068214

Pure Solid loader test 20 pcs 11069686

10.2 Folder locations
NOTE
Hidden folders

By default settings the following folder locations are hidden.

u Start the software [Windows Explorer] on the instrument.

u Navigate to folder options via the following navigation path: View ➔ Folder

Options ➔ View
u Activate the function [Show hidden files, folders and drives].

Explanation Type Folder
Method files .gfm C:\Users\Public\Documents\Buchi\Pure\meth-

ods
Run files .gkfr C:\Users\Public\Documents\Buchi\Pure\runs

10.3 Finding out separation conditions with the navigator
10.3.1 Open the navigator

Navigation path

➔ Gradient panel

u Navigate to the Gradient  panel according the navigation path.
u Tap the button [Navigator].

ð The display shows the dialog Navigator .
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10.3.2 TLC Silica

The TLC-Silica tool uses TLC separation data to provide a recommended gradient for
silica separations of 2 or 3 components.
Specification of the samples needed:
� Two different solvent concentrations
� Two separations
� Silica TLC plates

Precondition:
R The display shows the dialog Navigator . See Chapter 10.3.1 "Open the

navigator", page 67

u Select the TLC- Si l ica  tab.
u Select the radio button for two or three components.
u Select the weaker solvent at drop-down list A.
u Select the stronger solvent at drop-down list B.
u Enter the solvent B concentrations used in the TLC separations.
u Measure the distance the spot moved on the silica TLC plates.
u Divide the measured value by the distance the solvent traveled.
ð This is your Rf- value.
u Enter the value in the Rf entry field.
u Select the column you wish to use from the drop-down list
ð The column is selected.
ð The display shows the default flow rate.
u Adjust the flow rate according to your needs.
u Select the radio button for Speed or Purity.
u Tap the button [Calculate].
ð The display shows the results.
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u Adjust the following values if necessary:

� Column
� Flow rate
� Speed / Purity

u Tap the button [Accept].
ð The gradient is saved for a run.
ð The dialog box closes.

10.3.3 LC-C18

The LC-C18 Tool uses isocratic HPLC separation data to provide a recommended
gradient for reversed phase separations of 2 components.
Specification of the samples needed:
� Two isocratic runs on a HPLC column
� Different mobile phase solvent concentrations
� Retention times (t1 and t2) of the components from the chromatograms.

Precondition:
R The display shows the dialog Navigator . See Chapter 10.3.1 "Open the

navigator", page 67

u Select the LC-C18  tab.
u Select the HPLC column used from the drop-down list.
u Select the weaker solvent at drop-down list A.
u Select the stronger solvent at drop-down list B.
u Enter the solvent concentrations used in the HPLC separations.
u Enter the retention times for each separation under each chromatograph.
u Select the column you wish to use from the drop-down list
ð The column is selected.
ð The display shows the default flow rate.
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u Adjust the flow rate according to your needs.
u Select the radio button for Speed or Purity.
u Tap the button [Calculate].
ð The display shows the results.
u Tap the button [Accept].
ð The gradient is saved for a run.
ð The dialog box closes.

10.3.4 LC-Transfer

The LC-Transfer tool converts an HPLC gradient into a Flash Chromatography
gradient.
Specification of the sample needed:
� One run on a HPLC column (in gradient elution mode)
� Times %B changes (t1, t2 and t3)

Precondition:
R The display shows the dialog Navigator . See Chapter 10.3.1 "Open the

navigator", page 67
u Select the LC-Transfer tab.
u Select the HPLC column type used from the drop-down list.
u Enter the flow rate used in the HPLC separation.
u Enter the following HPLC gradient conditions:

� lower and higher %B
� times t1, t2 and t3

u Select the cartridge you wish to use for the Flash separation from the drop-down
list.

ð The cartridge is selected.
ð The display shows the default flow rate.
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u Adjust the flow rate according to your needs.
u Tap the button [Calculate].
ð The display shows the results.
u Adjust the following values if necessary:

� Flow rate

u Tap the button [Accept].
ð The gradient is saved for a run.
ð The dialog box closes.
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